Getting started with your

®

Connecting your Silhouette CAMEO®
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Check Included Items

The Silhouette CAMEO® comes with the items shown in the following list. Check that all the
items have been included before starting. If you are missing any items listed below, please contact
support@silhouetteamerica.com.

Silhouette CAMEO®
electronic cutting tool

Silhouette Studio‰
software

USB cable

A/C adapter and
power cable

crosscut blade

blade with
ratchet cap

12” cutting mat

Take the Silhouette CAMEO® from the box and remove the three strips of packing tape and foam support
as indicated by the following diagrams. These strips of tape and foam are used to hold the moving parts of
the Silhouette in place during shipment.
remove tape
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Install the Silhouette Studio‰ Software

PC Installation
1. Insert the included Silhouette Studio® CD into the CD drive of your computer.
2. Proceed through the installation process by following the on-screen prompts. If the installation window
does not automatically appear, browse to the CD drive in My Computer and double-click the setup.exe
program to run it.
3. If a “New Hardware Found” dialog box appears, follow the recommended instructions to accept your
system’s installation of the Silhouette driver.

Mac® Installation
1. Insert the included Silhouette Studio® CD into the CD drive of your computer.
2. Drag and drop the Silhouette Studio® application icon into the applications folder to install Silhouette
Studio®.
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Connect the Silhouette CAMEO®

Once the Silhouette Studio® software is installed, connect the Silhouette CAMEO® to the power supply.
Then connect the Silhouette to your computer with the included USB cable as shown in the diagram.

1

2

power

Turn the machine on by pressing the power button. Follow the touchscreen prompts to select your
language and perform initial setup. If your PC displays a “New Hardware Found” dialog box, follow the
recommended instructions to accept your system’s installation of the Silhouette driver.
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How to Cut with Your Silhouette CAMEO®
Opening the Silhouette Studio® Software
Locate the Silhouette Studio® icon on the desktop, or in the Start Menu on your PC (in
the Applications folder on a Mac®). Double-click the icon to run the application.
Once Silhouette Studio® has loaded, you will notice a blank 12” x 12” page on your
screen.

If you would like to change the page dimensions or orientation, you will find the page setup
options already opened in a panel on the right-hand side of the screen.
To access these page setup options in the future, click the Page Settings button in the
options toolbar in the upper right-hand corner of the window.
NOTE: To change the measurement units from the U.S. system to the metric system, choose
File -> Preferences… (Silhouette Studio® -> Preferences… on a Mac®). Under the Measurements
section of the preferences dialog box you will find several different units of measure.
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Drawing Text
To cut letters or words using any font on your computer, choose the text tool from the
toolbar on the left-hand side of the screen. With the text tool selected, click anywhere on
the page to begin typing.

After clicking on the page with the text tool, a blinking cursor will appear. Begin typing any letters/
words/phrases you choose.
While you are typing/editing text, the text options panel will appear on the right-hand side of the
screen. In this panel you can change the font, text size, weight, justification, character spacing and
line spacing. Use the mouse to highlight your text before making adjustments to the font, size,
weight, etc.
To finish typing your text, click anywhere off the page. This will end the text editing mode and
deselect the text. If you need to make a change to the text, double-click the text on the page using
the Select Tool (found on the left-hand toolbar).
To move your text around the page, click and drag it to a new location.
To resize your text, select the text and then click and drag one of the corner control handles.
To rotate your text, select the text, then click and drag the green circle displayed above the object.
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Drawing Simple Shapes
Silhouette Studio® has built-in functions to draw simple shapes such as circles, squares, rectangles,
lines, polygons, and freehand line art. Each of these tools can be found in the toolbar on the left-hand
side of the Silhouette Studio® window.

Lines

To draw a line, choose the Line Tool on the left-hand toolbar. Either click and drag with the
mouse to draw a line, or click once to start the line and click a second time to end.

Hold SHIFT while creating a line to make a perfectly vertical, horizontal, or 45° line.

Rectangles/Squares

To draw a rectangle, choose the Rectangle Tool from the left-hand toolbar. Either click and
drag with the mouse to draw a rectangle, or click once to set one corner and click a second
time to set the opposite corner.

Hold SHIFT while creating a rectangle to make a perfect square.
Hold ALT (OPTION on Mac®) to draw the rectangle from the center instead of one corner.
Hold SHIFT + ALT (SHIFT + OPTION on Mac®) to draw a perfect square centered on your original
click.
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Cutting Your Design
Preparing the Cutting Mat

Remove the non-stick liner from the cutting mat.
Position your paper or other media on the cutting mat according to the diagram shown in Silhouette
Studio®.

If you don’t see an image of the cutting mat under your document on the screen, click the
Page Setup button in the options toolbar in the upper right-hand corner of the window.
Position your image on the screen where you want it to cut on the mat. Be sure to keep your design
within the red margins on your page.
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Preparing the Silhouette to Cut
Turn the Silhouette CAMEO® on by pressing the power button and waiting for the machine to start up.
To feed the cutting mat into the Silhouette, lift the lid, align the left edge of the mat with the blue
alignment mark on the left side of the machine, press the mat against the white rollers, and press the
‘Load cut mat’ button on the LOAD screen.
white rollers

crosscut blade

Loading a material that has its own backing and does not require a cutting mat (such as vinyl),
requires a similar process as above but you should select ‘Load media’ instead.
If using a lined material without a cutting mat, you can use the crosscutter on the back of the
machine to trim your project after it’s done cutting. Simply place the crosscut blade into the track and
slide it across your material in the direction indicated on the crosscut blade. The crosscut blade can
be found in the storage compartment on the left side of the machine.

Adjusting the Rollers for Smaller Media
By adjusting the white rollers on the main roller shaft, the Silhouette CAMEO® can cut the following
media sizes: A4, letter, 12”, 13”.
Locate the release lever on the right side and turn it clockwise.

Twist the sliding roller so the pinchers are NOT in the notches.
Slide the roller to the desired media size and twist again to lock
the pinchers into place.

Return the release lever to the upright position to lock it in place.
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Prepare the blade plunger by removing the protective covering and adjusting the blade to the
appropriate number setting for the material you plan to cut. Refer to Silhouette Studio® for
recommended blade settings for different materials.

Blade setting

Material

1

Thin materials such as vinyl and smooth heat transfer material

2-3

Medium-weight materials such as paper, cardstock and flocked heat transfer material

4-6

Thicker materials such as textured cardstock and pattern papers

7-10

Thick materials such as canvas

To adjust the blade setting, place the grey ratchet cap on the end of the blade so the arrow on the cap
lines up with the red line on the blade. Turn the ratchet to the desired number.

ratchet cap

blade
numbered blade setting

NOTE: To remove fibers from blade housing, ratchet blade down to 0 and carefully grasp the
white tip turning it counterclockwise to remove the small end cap. Blow fibers away (do not
touch blade). Replace and hand-tighten cap.

Unlock the blade holder by turning the lock lever counter-clockwise. Place the blade housing in
the blade holder and turn the lock lever clockwise to secure the blade. Be sure the blade housing is
pressed completely into the holder.
blade
blade holder

loosen

fasten

lock lever
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Cutting
Click the Cut Settings button on the toolbar at the top of the screen. The Cut Settings
panel will appear on the right side of the screen.
You can adjust the cut order (if applicable) under the Cut Conditions menu

Cut Settings
button

Cut Order

Select
Media Type

Send to Silhouette

Within the Cut Settings panel, you will notice a list of common media types including various
weights of paper, vinyl, and other materials. Choose the appropriate media type from the list.
If the media you are cutting (or a similar media) does not appear in the list, you can choose
“Custom” from the list and manually adjust the speed and thickness for the Silhouette.
Generally, thicker materials require a higher thickness and intricate designs require a slower
cutting speed.
Once you have chosen the appropriate cut settings, click the Send to Silhouette button at the
bottom of the right panel.
Once the Silhouette is done cutting, press the “Unload” button.
Carefully peel away your cutout design. Peel the leftover paper/media off the cutting mat.
Use a Silhouette scraper tool to scrape excess paper pieces from the mat.
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My Library
Browsing Designs
Click the My Library button to view the Silhouette designs you have on your computer.
Silhouette Studio® includes 50 free designs to help you get started. Connect your CAMEO
to your computer and power it on to get your 50 free designs.
Click the Show All Designs shortcut in the left panel of My Library to view all 50 designs included
with your software.

Click the icon next to the My Library folder
to expand the folder and view its contents. This
folder initially contains the 50 free designs included.
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Use the View as Icons button and View as List button to change the view of
your designs in the right panel. In List View, you can sort by name, design type,
artist name, and date downloaded.
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Organizing Designs
You can organize your designs within My Library for your convenience by creating new folders for
your designs.
With the My Library folder highlighted, click the New Folder button in the toolbar at the
top of the My Library window, then type a name for your new folder.
Select the My Library folder again to reveal the 50 designs you already have.
Drag any design from the right panel into your newly created folder in the folders panel on the left.
The numbers in parentheses next to each folder indicate how many shapes are included in each
folder.
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Searching Designs
At the top of the My Library window you will find a search box. Click in the text box and type a
keyword to search your library of images. Search results will display in the right panel of My Library.
search box

If you would like to view the keywords and description for a shape used for searching, right click
(Control Click on Mac®) and choose Show Properties. At the bottom of My Library details about
the highlighted shape will appear. Shapes downloaded from the Silhouette Design Store will contain
several keywords and a description or instructions.

Using Designs in My Library
Using the folders in My Library, navigate to a design that you’d like to cut. Double-click the design to
place it on your page in the software.
This will automatically close My Library which can be easily re-opened by clicking the My
Library button on the left toolbar again.
To close My Library without pasting a design, click the Close button in the upper right-hand corner of
the My Library area.
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Downloading New Shapes
Connecting to the Silhouette Design Store
The Silhouette Design Store contains thousands of designs to cut with your Silhouette ranging from
simple cutouts to intricate patterns and designs. Most shapes are only 99¢. Generally, a free shape is
posted every week as well.
To access the Silhouette Design Store, click the Design Store button in the toolbar on the
left side of the window.
The free design of the week will be displayed on the home page that appears.
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Browsing for new designs
The Silhouette Design Store works like any other web page and can be navigated by clicking on
various links to browse new releases, popular designs, etc. The home page contains popular and new
designs that you may be interested in.
For now, try downloading a free design by clicking this week’s free design button on the home page,
or searching for the free design named “butterfly_1510”.

Click on the design in the search results to view details about the design.
Click the Add to Cart button to add this free design to your shopping cart.
Locate the shopping cart icon in the upper right-hand corner of the window and click
it to view your shopping cart. Your shopping cart total should be $0.00.
Click the Checkout button to proceed. At this time the system will ask you to sign in before
downloading. Creating a new account only takes a few seconds. Click the Sign up Free link on the
login page to create a new account.
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Creating an account
Several different account types exist. Once you’re more familiar with the Silhouette Design Store, you
may wish to purchase a subscription and download dozens of designs each month.

In order to create a free account and buy designs one at a time, choose the “Sign up FREE” option.
You will be asked for your name, email and password in order to create an account. Type your
information and click the Sign Up button.
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Once your account is created, you will need to access your shopping cart again and try the
checkout process once more. You will be asked to validate your password each time you
download designs.
Type your password to authorize the download.

As your design begins to download, it will appear in the Recent Downloads folder of My Library which
will appear on the screen showing the download progress. Any new designs you download from the
Silhouette Design Store will appear in this special folder and can be moved to any folder of your choice.
Double-click your newly downloaded design to paste it into your current document.
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Using your trial subscription card
If your Silhouette came with a trial subscription card, you may use it to purchase designs from the
Silhouette Design Store. To do this, click the ‘My Account’ link at the top of any page within the Store.

From the My Account page, click the ‘REDEEM A PROMOTIONAL DOWNLOAD CODE’ link. A
screen will appear where you can type the code found on the back of your trial subscription card.
Type your download code and press the ‘Apply Card’ button.
The trial subscription card entitles you to a Basic Subscription to the Silhouette Design Store for 1
month. Once your trial has been activated, the card is no longer needed and can be discarded.
Your available subscription credits can be viewed in the upper right-hand corner of the screen below
the search bar.
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Using Your USB Device with the
Silhouette CAMEO®
Saving to Your USB Device
Open or create a shape in the Silhouette Studio® software.
Resize your design to the size you want it to cut and position it as desired.
Insert a USB memory device into your computer.
Go to the File > Save As option (or CTRL + SHIFT + S) and save your design to the USB memory
device.
Remove the USB memory device from your computer.
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Using a USB Device in your Silhouette CAMEO®
With the Silhouette CAMEO® powered on, insert your USB memory device into the slot on the side
of the machine. Load your material into the Silhouette.
With the USB memory device inserted and your cutting mat/media loaded, press the Browse USB
button option on the touchscreen to enter the USB device menu.
From here, you may press the Select file button to browse to your desired image on the USB
memory device. Up and down arrows will allow you to scroll up and down in the current directory.
Left and right arrows will allow you to navigate through different directories on the USB memory
device. Once your desired image is highlighted, press the Select button.
Once your image is selected, you may then press the Cut settings button in order to adjust the
Thickness, Speed, and other desired settings for your material type in use.
When ready, you may then press the Cut button on the touchscreen and your job will cut according
to your specifications.

LOAD

SEND PROJECT
FROM SOFTWARE
-OR-

Browse
Load
cutUSB
mat
Repeat
job
Load
media
Unload
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Silhouette CAMEO® Safety Precautions
Keep the Silhouette CAMEO® out of reach of children.
Review and keep this document for future reference.
The Silhouette CAMEO® is an electronic cutting tool and requires careful use and handling.
To avoid personal injury or damage to the machine, please read the following safety
precautions.
Conventions used in this guide
In order to use the Silhouette CAMEO® safely and
correctly, as well as to prevent human injury and
property damage, careful attention must be given
to each of the safety precautions in this document.
Failure to comply with these precautions may
void the warranty of the product and any
personal or property damage liability.

Safety Precautions

Description of safety symbols
The
symbol indicates information
that requires careful attention (which
includes warnings).
The
symbol indicates an action that
is strictly prohibited.
The
symbol, whether next to an
image or included in text, indicates an
action that must be performed.

WARNING

Do not touch moving parts while the Silhouette is cutting.

Keep hands and other objects away from moving parts when the machine is plugged in.
Do not disassemble, repair, or remodel the Silhouette.
Tampering with the Silhouette hardware can cause electrical shock or fire due to current leakage.
If your Silhouette needs repair, please contact Silhouette Customer Service.
Do not connect the Silhouette to a non-rated power supply.
Use of a different supply voltage may result in electrical shock or a fire hazard due to current
leakage.
Do not use the Silhouette in a location where it may be exposed to water, humidity,
or dust.
If the Silhouette begins to smoke, gets too hot, emits a strange odor, or otherwise
functions abnormally, do not continue using it. Unplug the AC adapter from the
electrical socket.
Use of the Silhouette CAMEO® when overheated may result in a fire hazard or
electrical shock.
Do not try to repair the Silhouette yourself.
Do not allow dust or metals near the power plug.
A dirty power plug may result in electrical shock or a fire hazard due to current
leakage.
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Do not use the AC adapter or power cord if it is damaged.
Use of a damaged power cord or AC adapter may result in electrical shock or fire.
Replace damaged power cords and AC adapters.
Only use the AC adapter included in the Silhouette CAMEO® box.
Use of other AC adapters may cause malfunctions or result in electrical shock or fire.
Be sure to connect the AC adapter to the CAMEO before plugging it into the wall.
The Silhouette blade is sharp.
Handle the blade housing with care and do not touch the blade itself.

Do not use or store the Silhouette CAMEO® in a location exposed to direct sunlight or a direct
draft of an air conditioner or heater.
Excessive heat, dust and/or humidity can cause the machine to malfunction.
Do not use the Silhouette CAMEO® in a location subject to excessive vibration or electrical
noise.

Do not pull on the power cable to unplug the Silhouette.

If a foreign object/substance enters the Silhouette during operation, cancel the current project
by turning the machine off.
Do not attempt to remove the foreign object or continue cutting.
Do not attempt to lubricate the Silhouette CAMEO®.
The Silhouette does not require lubricant or any liquid agent to operate normally.
Do not use any liquid cleaning agents or any other liquids on the interior of the Silhouette
CAMEO® or around the Silhouette control panel.
Liquids will ruin the functionality of the machine.
Be sure to leave enough space around the Silhouette CAMEO® during operation so the machine,
media, and cutting mat do not touch surrounding objects.
Keep the Silhouette CAMEO® at least 3 feet away from any light or heat sources.
Always use the correct blade setting for the material you are cutting.
Using too deep of a setting can cause the cutting mat to wear out and can adversely affect cutting
performance.
When manually moving the cutting carriage, use caution and move slowly so as not to damage the
Silhouette hardware.
For any questions or concerns contact Silhouette Customer Service at support@silhouetteamerica.com
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Where to Find More Information
Complete User’s Manual

View the complete, illustrated User’s Manual within Silhouette Studio® by clicking Help -> User’s
Manual.

Website

Visit the tutorials section of www.silhouetteamerica.com for help with specific features and step-bystep instructions on how to cut different media types with the Silhouette CAMEO®.

Blog

Visit the official Silhouette blog at blog.silhouetteamerica.com for ideas of new projects you can
create. Many blog posts contain step-by-step instructions for advanced uses of Silhouette products
and software.

Newsletter
Sign up for the Silhouette newsletter at www.silhouetteamerica.com to receive product updates and
special offers via email.

Customer Service

If you have any further questions, feel free to contact customer service:
Silhouette America, Inc.
support@silhouetteamerica.com
(800) 859-8243 (US only)
(801) 983-8937

www.silhouetteamerica.com
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